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Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.

Details

Product Status Active

Number of LABs/CLBs 11500

Number of Logic Elements/Cells 92000

Total RAM Bits 4526080

Number of I/O 295

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature 0°C ~ 85°C (TJ)

Package / Case 484-BBGA

Supplier Device Package 484-FPBGA (23x23)

Purchase URL https://www.e-xfl.com/product-detail/lattice-semiconductor/lfe3-95ea-8lfn484c
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Features
 Higher Logic Density for Increased System 

Integration
• 17K to 149K LUTs
• 116 to 586 I/Os

 Embedded SERDES 
• 150 Mbps to 3.2 Gbps for Generic 8b10b, 10-bit 

SERDES, and 8-bit SERDES modes
• Data Rates 230 Mbps to 3.2 Gbps per channel 

for all other protocols
• Up to 16 channels per device: PCI Express, 

SONET/SDH, Ethernet (1GbE, SGMII, XAUI), 
CPRI, SMPTE 3G and Serial RapidIO

 sysDSP™
• Fully cascadable slice architecture
• 12 to 160 slices for high performance multiply 

and accumulate
• Powerful 54-bit ALU operations
• Time Division Multiplexing MAC Sharing
• Rounding and truncation
• Each slice supports

— Half 36x36, two 18x18 or four 9x9 multipliers
— Advanced 18x36 MAC and 18x18 Multiply-

Multiply-Accumulate (MMAC) operations
 Flexible Memory Resources

• Up to 6.85Mbits sysMEM™ Embedded Block 
RAM (EBR) 

• 36K to 303K bits distributed RAM
 sysCLOCK Analog PLLs and DLLs

• Two DLLs and up to ten PLLs per device
 Pre-Engineered Source Synchronous I/O

• DDR registers in I/O cells

• Dedicated read/write levelling functionality
• Dedicated gearing logic
• Source synchronous standards support

— ADC/DAC, 7:1 LVDS, XGMII
— High Speed ADC/DAC devices

• Dedicated DDR/DDR2/DDR3 memory with DQS 
support

• Optional Inter-Symbol Interference (ISI) 
correction on outputs

 Programmable sysI/O™ Buffer Supports 
Wide Range of Interfaces

• On-chip termination
• Optional equalization filter on inputs
• LVTTL and LVCMOS 33/25/18/15/12
• SSTL 33/25/18/15 I, II
• HSTL15 I and HSTL18 I, II
• PCI and Differential HSTL, SSTL
• LVDS, Bus-LVDS, LVPECL, RSDS, MLVDS

 Flexible Device Configuration 
• Dedicated bank for configuration I/Os
• SPI boot flash interface
• Dual-boot images supported
• Slave SPI
• TransFR™ I/O for simple field updates
• Soft Error Detect embedded macro

 System Level Support
• IEEE 1149.1 and IEEE 1532 compliant
• Reveal Logic Analyzer
• ORCAstra FPGA configuration utility
• On-chip oscillator for initialization & general use
• 1.2 V core power supply

Table 1-1. LatticeECP3™ Family Selection Guide
Device ECP3-17 ECP3-35 ECP3-70 ECP3-95 ECP3-150

LUTs (K) 17 33 67 92 149
sysMEM Blocks (18 Kbits) 38 72 240 240 372
Embedded Memory (Kbits) 700 1327 4420 4420 6850
Distributed RAM Bits (Kbits) 36 68 145 188 303
18 x 18 Multipliers 24 64 128 128 320
SERDES (Quad) 1 1 3 3 4
PLLs/DLLs 2 / 2 4 / 2 10 / 2 10 / 2 10 / 2
Packages and SERDES Channels/ I/O Combinations
328 csBGA (10 x 10 mm) 2 / 116
256 ftBGA (17 x 17 mm) 4 / 133 4 / 133   
484 fpBGA (23 x 23 mm) 4 / 222 4 / 295 4 / 295 4 / 295  
672 fpBGA (27 x 27 mm) 4 / 310 8 / 380 8 / 380 8 / 380
1156 fpBGA (35 x 35 mm)   12 / 490 12 / 490 16 / 586

LatticeECP3 Family Data Sheet
Introduction
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Introduction
The LatticeECP3™ (EConomy Plus Third generation) family of FPGA devices is optimized to deliver high perfor-
mance features such as an enhanced DSP architecture, high speed SERDES and high speed source synchronous 
interfaces in an economical FPGA fabric. This combination is achieved through advances in device architecture 
and the use of 65 nm technology making the devices suitable for high-volume, high-speed, low-cost applications.

The LatticeECP3 device family expands look-up-table (LUT) capacity to 149K logic elements and supports up to 
586 user I/Os. The LatticeECP3 device family also offers up to 320 18 x 18 multipliers and a wide range of parallel 
I/O standards.

The LatticeECP3 FPGA fabric is optimized with high performance and low cost in mind. The LatticeECP3 devices 
utilize reconfigurable SRAM logic technology and provide popular building blocks such as LUT-based logic, distrib-
uted and embedded memory, Phase Locked Loops (PLLs), Delay Locked Loops (DLLs), pre-engineered source 
synchronous I/O support, enhanced sysDSP slices and advanced configuration support, including encryption and 
dual-boot capabilities.

The pre-engineered source synchronous logic implemented in the LatticeECP3 device family supports a broad 
range of interface standards, including DDR3, XGMII and 7:1 LVDS.

The LatticeECP3 device family also features high speed SERDES with dedicated PCS functions. High jitter toler-
ance and low transmit jitter allow the SERDES plus PCS blocks to be configured to support an array of popular 
data protocols including PCI Express, SMPTE, Ethernet (XAUI, GbE, and SGMII) and CPRI. Transmit Pre-empha-
sis and Receive Equalization settings make the SERDES suitable for transmission and reception over various 
forms of media.

The LatticeECP3 devices also provide flexible, reliable and secure configuration options, such as dual-boot capa-
bility, bit-stream encryption, and TransFR field upgrade features.

The Lattice Diamond™ and ispLEVER® design software allows large complex designs to be efficiently imple-
mented using the LatticeECP3 FPGA family. Synthesis library support for LatticeECP3 is available for popular logic 
synthesis tools. Diamond and ispLEVER tools use the synthesis tool output along with the constraints from its floor 
planning tools to place and route the design in the LatticeECP3 device. The tools extract the timing from the routing 
and back-annotate it into the design for timing verification. 

Lattice provides many pre-engineered IP (Intellectual Property) modules for the LatticeECP3 family. By using these 
configurable soft core IPs as standardized blocks, designers are free to concentrate on the unique aspects of their 
design, increasing their productivity.
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Figure 2-1. Simplified Block Diagram, LatticeECP3-35 Device (Top Level)

PFU Blocks 
The core of the LatticeECP3 device consists of PFU blocks, which are provided in two forms, the PFU and PFF. 
The PFUs can be programmed to perform Logic, Arithmetic, Distributed RAM and Distributed ROM functions. PFF 
blocks can be programmed to perform Logic, Arithmetic and ROM functions. Except where necessary, the remain-
der of this data sheet will use the term PFU to refer to both PFU and PFF blocks. 

Each PFU block consists of four interconnected slices numbered 0-3 as shown in Figure 2-2. Each slice contains 
two LUTs. All the interconnections to and from PFU blocks are from routing. There are 50 inputs and 23 outputs 
associated with each PFU block. 

SERDES/PCS 
CH 3

SERDES/PCS 
CH 2

SERDES/PCS 
CH 1

SERDES/PCS 
CH 0

sysIO
Bank 

7 

sysIO
Bank

2 

sysIO 
Bank 0 

sysIO 
Bank 1 

sysIO Bank 3 sysIO Bank 6 

Configuration Logic: 
Dual-boot, Encryption 
and Transparent Updates

On-chip Oscillator

Pre-engineered Source 
Synchronous Support:
DDR3 - 800 Mbps
Generic - Up to 1 Gbps

Flexible Routing:
Optimized for speed 
and routability

Flexible sysIO:
LVCMOS, HSTL, 
SSTL, LVDS
Up to 486 I/Os

Programmable 
Function Units:
Up to 149K LUTs

sysCLOCK 
PLLs & DLLs:
Frequency Synthesis 
and Clock Alignment

Enhanced DSP 
Slices: Multiply, 
Accumulate and ALU

JTAG

sysMEM Block 
RAM: 18 Kbit

3.2 Gbps SERDES

Note: There is no Bank 4 or Bank 5 in LatticeECP3 devices.
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Figure 2-4. General Purpose PLL Diagram

Table 2-4 provides a description of the signals in the PLL blocks. 

Table 2-4. PLL Blocks Signal Descriptions

Delay Locked Loops (DLL)
In addition to PLLs, the LatticeECP3 family of devices has two DLLs per device. 

CLKI is the input frequency (generated either from the pin or routing) for the DLL. CLKI feeds into the output muxes 
block to bypass the DLL, directly to the DELAY CHAIN block and (directly or through divider circuit) to the reference 
input of the Phase Detector (PD) input mux. The reference signal for the PD can also be generated from the Delay 
Chain signals. The feedback input to the PD is generated from the CLKFB pin or from a tapped signal from the 
Delay chain. 

The PD produces a binary number proportional to the phase and frequency difference between the reference and 
feedback signals. Based on these inputs, the ALU determines the correct digital control codes to send to the delay 

Signal I/O Description 

CLKI I Clock input from external pin or routing 

CLKFB I PLL feedback input from CLKOP, CLKOS, or from a user clock (pin or logic) 

RST I “1” to reset PLL counters, VCO, charge pumps and M-dividers

RSTK I “1” to reset K-divider

WRDEL I DPA Fine Delay Adjust input

CLKOS O PLL output to clock tree (phase shifted/duty cycle changed) 

CLKOP O PLL output to clock tree (no phase shift) 

CLKOK O PLL output to clock tree through secondary clock divider 

CLKOK2 O PLL output to clock tree (CLKOP divided by 3)

LOCK O “1” indicates PLL LOCK to CLKI 

FDA [3:0] I Dynamic fine delay adjustment on CLKOS output

DRPAI[3:0] I Dynamic coarse phase shift, rising edge setting

DFPAI[3:0] I Dynamic coarse phase shift, falling edge setting 

CLKFB
Divider

RST

CLKFB

CLKI

LOCK

CLKOP

CLKOS

RSTK

WRDEL

FDA[3:0]

CLKOK2

CLKOK

CLKI
Divider

PFD VCO/
Loop Filter

CLKOP
Divider

Phase/
Duty Cycle/
Duty Trim

Duty Trim

CLKOK
Divider

Lock
Detect

3

DRPAI[3:0]
DFPAI[3:0]
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On-Chip Programmable Termination
The LatticeECP3 supports a variety of programmable on-chip terminations options, including:

• Dynamically switchable Single-Ended Termination with programmable resistor values of 40, 50, or 60 Ohms. 
External termination to Vtt should be used for DDR2 and DDR3 memory controller implementation.

• Common mode termination of 80, 100, 120 Ohms for differential inputs 

Figure 2-39. On-Chip Termination

See Table 2-12 for termination options for input modes.

Table 2-12. On-Chip Termination Options for Input Modes

IO_TYPE TERMINATE to VTT1, 2 DIFFERENTIAL TERMINATION RESISTOR1

LVDS25 þ 80, 100, 120

BLVDS25 þ 80, 100, 120

MLVDS þ 80, 100, 120

HSTL18_I 40, 50, 60 þ

HSTL18_II 40, 50, 60 þ

HSTL18D_I 40, 50, 60 þ

HSTL18D_II 40, 50, 60 þ

HSTL15_I 40, 50, 60 þ

HSTL15D_I 40, 50, 60 þ

SSTL25_I 40, 50, 60 þ

SSTL25_II 40, 50, 60 þ

SSTL25D_I 40, 50, 60 þ

SSTL25D_II 40, 50, 60 þ

SSTL18_I 40, 50, 60 þ

SSTL18_II 40, 50, 60 þ

SSTL18D_I 40, 50, 60 þ

SSTL18D_II 40, 50, 60 þ

SSTL15 40, 50, 60 þ

SSTL15D 40, 50, 60 þ

1. TERMINATE to VTT and DIFFRENTIAL TERMINATION RESISTOR when turned on can only have 
one setting per bank. Only left and right banks have this feature.
Use of TERMINATE to VTT and DIFFRENTIAL TERMINATION RESISTOR are mutually exclusive in 
an I/O bank.
On-chip termination tolerance +/– 20%

2. External termination to VTT should be used when implementing DDR2 and DDR3 memory controller.

Parallel Single-Ended Input Differential Input

Zo

+

-

Vtt

Control Signal

Off-chip On-Chip

Programmable resistance (40, 50 and 60 Ohms)

Z0

Z0

+

-

Off-chip On-Chip

Vtt*

*Vtt must be left floating for this termination
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There are some restrictions to be aware of when using spread spectrum. When a quad shares a PCI Express x1 
channel with a non-PCI Express channel, ensure that the reference clock for the quad is compatible with all proto-
cols within the quad. For example, a PCI Express spread spectrum reference clock is not compatible with most 
Gigabit Ethernet applications because of tight CTC ppm requirements.

While the LatticeECP3 architecture will allow the mixing of a PCI Express channel and a Gigabit Ethernet, Serial 
RapidIO or SGMII channel within the same quad, using a PCI Express spread spectrum clocking as the transmit 
reference clock will cause a violation of the Gigabit Ethernet, Serial RapidIO and SGMII transmit jitter specifica-
tions.

For further information on SERDES, please see TN1176, LatticeECP3 SERDES/PCS Usage Guide.

IEEE 1149.1-Compliant Boundary Scan Testability 
All LatticeECP3 devices have boundary scan cells that are accessed through an IEEE 1149.1 compliant Test 
Access Port (TAP). This allows functional testing of the circuit board on which the device is mounted through a 
serial scan path that can access all critical logic nodes. Internal registers are linked internally, allowing test data to 
be shifted in and loaded directly onto test nodes, or test data to be captured and shifted out for verification. The test 
access port consists of dedicated I/Os: TDI, TDO, TCK and TMS. The test access port has its own supply voltage 
VCCJ and can operate with LVCMOS3.3, 2.5, 1.8, 1.5 and 1.2 standards. 

For more information, please see TN1169, LatticeECP3 sysCONFIG Usage Guide.

Device Configuration 
All LatticeECP3 devices contain two ports that can be used for device configuration. The Test Access Port (TAP), 
which supports bit-wide configuration, and the sysCONFIG port, support dual-byte, byte and serial configuration. 
The TAP supports both the IEEE Standard 1149.1 Boundary Scan specification and the IEEE Standard 1532 In- 
System Configuration specification. The sysCONFIG port includes seven I/Os used as dedicated pins with the 
remaining pins used as dual-use pins. See TN1169, LatticeECP3 sysCONFIG Usage Guide for more information 
about using the dual-use pins as general purpose I/Os.

There are various ways to configure a LatticeECP3 device:

1. JTAG

2. Standard Serial Peripheral Interface (SPI and SPIm modes) - interface to boot PROM memory

3. System microprocessor to drive a x8 CPU port (PCM mode)

4. System microprocessor to drive a serial slave SPI port (SSPI mode)

5. Generic byte wide flash with a MachXO™ device, providing control and addressing

On power-up, the FPGA SRAM is ready to be configured using the selected sysCONFIG port. Once a configuration 
port is selected, it will remain active throughout that configuration cycle. The IEEE 1149.1 port can be activated any 
time after power-up by sending the appropriate command through the TAP port. 

LatticeECP3 devices also support the Slave SPI Interface. In this mode, the FPGA behaves like a SPI Flash device 
(slave mode) with the SPI port of the FPGA to perform read-write operations.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
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Enhanced Configuration Options

LatticeECP3 devices have enhanced configuration features such as: decryption support, TransFR™ I/O and dual-
boot image support.

1. TransFR (Transparent Field Reconfiguration)
TransFR I/O (TFR) is a unique Lattice technology that allows users to update their logic in the field without 
interrupting system operation using a single ispVM command. TransFR I/O allows I/O states to be frozen dur-
ing device configuration. This allows the device to be field updated with a minimum of system disruption and 
downtime. See TN1087, Minimizing System Interruption During Configuration Using TransFR Technology for 
details.

2. Dual-Boot Image Support
Dual-boot images are supported for applications requiring reliable remote updates of configuration data for the 
system FPGA. After the system is running with a basic configuration, a new boot image can be downloaded 
remotely and stored in a separate location in the configuration storage device. Any time after the update the 
LatticeECP3 can be re-booted from this new configuration file. If there is a problem, such as corrupt data dur-
ing download or incorrect version number with this new boot image, the LatticeECP3 device can revert back to 
the original backup golden configuration and try again. This all can be done without power cycling the system. 
For more information, please see TN1169, LatticeECP3 sysCONFIG Usage Guide.

Soft Error Detect (SED) Support
LatticeECP3 devices have dedicated logic to perform Cycle Redundancy Code (CRC) checks. During configura-
tion, the configuration data bitstream can be checked with the CRC logic block. In addition, the LatticeECP3 device 
can also be programmed to utilize a Soft Error Detect (SED) mode that checks for soft errors in configuration 
SRAM. The SED operation can be run in the background during user mode. If a soft error occurs, during user 
mode (normal operation) the device can be programmed to generate an error signal.

For further information on SED support, please see TN1184, LatticeECP3 Soft Error Detection (SED) Usage 
Guide.

External Resistor
LatticeECP3 devices require a single external, 10 kOhm ±1% value between the XRES pin and ground. Device 
configuration will not be completed if this resistor is missing. There is no boundary scan register on the external 
resistor pad.

On-Chip Oscillator 
Every LatticeECP3 device has an internal CMOS oscillator which is used to derive a Master Clock (MCCLK) for 
configuration. The oscillator and the MCCLK run continuously and are available to user logic after configuration is 
completed. The software default value of the MCCLK is nominally 2.5 MHz. Table 2-16 lists all the available 
MCCLK frequencies. When a different Master Clock is selected during the design process, the following sequence 
takes place: 

1. Device powers up with a nominal Master Clock frequency of 3.1 MHz.

2. During configuration, users select a different master clock frequency.

3. The Master Clock frequency changes to the selected frequency once the clock configuration bits are received.

4. If the user does not select a master clock frequency, then the configuration bitstream defaults to the MCCLK 
frequency of 2.5 MHz.

This internal 130 MHz +/– 15% CMOS oscillator is available to the user by routing it as an input clock to the clock 
tree. For further information on the use of this oscillator for configuration or user mode, please see TN1169, 
LatticeECP3 sysCONFIG Usage Guide.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=21638
www.latticesemi.com/dynamic/view_document.cfm?document_id=32323
www.latticesemi.com/dynamic/view_document.cfm?document_id=32323
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
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Hot Socketing Specifications1, 2, 3

Hot Socketing Requirements1, 2

ESD Performance
Please refer to the LatticeECP3 Product Family Qualification Summary for complete qualification data, including 
ESD performance.

Symbol Parameter Condition Min. Typ. Max. Units

IDK_HS4 Input or I/O Leakage Current 0 VIN  VIH (Max.) — — +/–1 mA

IDK5 Input or I/O Leakage Current
0  VIN < VCCIO — — +/–1 mA

VCCIO  VIN  VCCIO + 0.5V — 18 — mA

1. VCC, VCCAUX and VCCIO should rise/fall monotonically.
2. IDK is additive to IPU, IPD or IBH. 
3. LVCMOS and LVTTL only.
4. Applicable to general purpose I/O pins located on the top and bottom sides of the device.
5. Applicable to general purpose I/O pins located on the left and right sides of the device.

Description Min. Typ. Max. Units

Input current per SERDES I/O pin when device is powered down and inputs 
driven. — — 8 mA

1. Assumes the device is powered down, all supplies grounded, both P and N inputs driven by CML driver with maximum allowed VCCOB 
(1.575 V), 8b10b data, internal AC coupling.

2. Each P and N input must have less than the specified maximum input current. For a 16-channel device, the total input current would be 8 mA*16 
channels *2 input pins per channel = 256 mA

http://www.latticesemi.com/dynamic/view_document.cfm?document_id=34723
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LatticeECP3 Supply Current (Standby)1, 2, 3, 4, 5, 6

Over Recommended Operating Conditions

Symbol Parameter Device

Typical

Units–6L, –7L, –8L –6, –7, –8

ICC Core Power Supply Current

ECP-17EA 29.8 49.4 mA

ECP3-35EA 53.7 89.4 mA

ECP3-70EA 137.3 230.7 mA

ECP3-95EA 137.3 230.7 mA

ECP3-150EA 219.5 370.9 mA

ICCAUX Auxiliary Power Supply Current

ECP-17EA 18.3 19.4 mA

ECP3-35EA 19.6 23.1 mA

ECP3-70EA 26.5 32.4 mA

ECP3-95EA 26.5 32.4 mA

ECP3-150EA 37.0 45.7 mA

ICCPLL PLL Power Supply Current (Per PLL)

ECP-17EA 0.0 0.0 mA

ECP3-35EA 0.1 0.1 mA

ECP3-70EA 0.1 0.1 mA

ECP3-95EA 0.1 0.1 mA

ECP3-150EA 0.1 0.1 mA

ICCIO Bank Power Supply Current (Per Bank)

ECP-17EA 1.3 1.4 mA

ECP3-35EA 1.3 1.4 mA

ECP3-70EA 1.4 1.5 mA

ECP3-95EA 1.4 1.5 mA

ECP3-150EA 1.4 1.5 mA

ICCJ JTAG Power Supply Current All Devices 2.5 2.5 mA

ICCA
Transmit, Receive, PLL and 
Reference Clock Buffer Power Supply

ECP-17EA 6.1 6.1 mA

ECP3-35EA 6.1 6.1 mA

ECP3-70EA 18.3 18.3 mA

ECP3-95EA 18.3 18.3 mA

ECP3-150EA 24.4 24.4 mA

1. For further information on supply current, please see the list of technical documentation at the end of this data sheet.
2. Assumes all outputs are tristated, all inputs are configured as LVCMOS and held at the VCCIO or GND.
3. Frequency 0 MHz.
4. Pattern represents a “blank” configuration data file.
5. TJ = 85 °C, power supplies at nominal voltage.
6. To determine the LatticeECP3 peak start-up current data, use the Power Calculator tool.
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fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 683 — 688 — 690 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 683 — 688 — 690 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data Aligned at Pin (GDDRX1_TX.SCLK.Aligned)10 

tDIBGDDR Data Invalid Before Clock ECP3-150EA — 335 — 338 — 341 ps

tDIAGDDR Data Invalid After Clock ECP3-150EA — 335 — 338 — 341 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

tDIAGDDR Data Invalid After Clock ECP3-70EA/95EA — 339 — 343 — 347 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-35EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-35EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDIBGDDR Data Invalid Before Clock ECP3-17EA — 322 — 320 — 321 ps

tDIAGDDR Data Invalid After Clock ECP3-17EA — 322 — 320 — 321 ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX1 Output with Clock and Data (<10 Bits Wide) Centered at Pin (GDDRX1_TX.DQS.Centered)10 

Left and Right Sides

tDVBGDDR Data Valid Before CLK ECP3-150EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-150EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

tDVAGDDR Data Valid After CLK ECP3-70EA/95EA 657 — 652 — 650 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-70EA/95EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-35EA 670 — 675 — 676 — ps

tDVAGDDR Data Valid After CLK ECP3-35EA 670 — 675 — 676 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-35EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-17EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-17EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-17EA — 250 — 250 — 250 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Aligned at Pin (GDDRX2_TX.Aligned)

Left and Right Sides

tDIBGDDR Data Invalid Before Clock All ECP3EA Devices — 200 — 210 — 220 ps

tDIAGDDR Data Invalid After Clock All ECP3EA Devices — 200 — 210 — 220 ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 500 — 420 — 375 MHz

Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Centered at Pin  Using DQSDLL (GDDRX2_TX.DQSDLL.Centered)11

Left and Right Sides 

tDVBGDDR Data Valid Before CLK All ECP3EA Devices 400 — 400 — 431 — ps

tDVAGDDR Data Valid After CLK All ECP3EA Devices 400 — 400 — 432 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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Generic DDRX2 Output with Clock and Data (>10 Bits Wide) Centered at Pin  Using PLL (GDDRX2_TX.PLL.Centered)10

Left and Right Sides

tDVBGDDR Data Valid Before CLK All ECP3EA Devices 285 — 370 — 431 — ps

tDVAGDDR Data Valid After CLK All ECP3EA Devices 285 — 370 — 432 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 500 — 420 — 375 MHz

Memory Interface

DDR/DDR2 I/O Pin Parameters (Input Data are Strobe Edge Aligned, Output Strobe Edge is Data Centered)4 

tDVADQ Data Valid After DQS (DDR Read) All ECP3 Devices — 0.225 — 0.225 — 0.225 UI

tDVEDQ Data Hold After DQS (DDR Read) All ECP3 Devices 0.64 — 0.64 — 0.64 — UI

tDQVBS Data Valid Before DQS All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

tDQVAS Data Valid After DQS  All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

fMAX_DDR DDR Clock Frequency All ECP3 Devices 95 200 95 200 95 166 MHz

fMAX_DDR2 DDR2 clock frequency All ECP3 Devices 125 266 125 200 125 166 MHz

DDR3 (Using PLL for SCLK) I/O Pin Parameters

tDVADQ Data Valid After DQS (DDR Read) All ECP3 Devices — 0.225 — 0.225 — 0.225 UI

tDVEDQ Data Hold After DQS (DDR Read) All ECP3 Devices 0.64 — 0.64 — 0.64 — UI

tDQVBS Data Valid Before DQS All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

tDQVAS Data Valid After DQS  All ECP3 Devices 0.25 — 0.25 — 0.25 — UI

fMAX_DDR3 DDR3 clock frequency All ECP3 Devices 300 400 266 333 266 300 MHz

DDR3 Clock Timing

tCH (avg)9 Average High Pulse Width All ECP3 Devices 0.47 0.53 0.47 0.53 0.47 0.53 UI

tCL (avg)9 Average Low Pulse Width All ECP3 Devices 0.47 0.53 0.47 0.53 0.47 0.53 UI

tJIT (per, lck)9 Output Clock Period Jitter During 
DLL Locking Period All ECP3 Devices –90 90 –90 90 –90 90 ps

tJIT (cc, lck)9 Output Cycle-to-Cycle Period Jit-
ter During DLL Locking Period All ECP3 Devices — 180 — 180 — 180 ps

1. Commercial timing numbers are shown. Industrial numbers are typically slower and can be extracted from the Diamond or ispLEVER soft-
ware.

2. General I/O timing numbers based on LVCMOS 2.5, 12mA, Fast Slew Rate, 0pf load.
3. Generic DDR timing numbers based on LVDS I/O.
4. DDR timing numbers based on SSTL25. DDR2 timing numbers based on SSTL18.
5. DDR3 timing numbers based on SSTL15.
6. Uses LVDS I/O standard.
7. The current version of software does not support per bank skew numbers; this will be supported in a future release.
8. Maximum clock frequencies are tested under best case conditions. System performance may vary upon the user environment.
9. Using settings generated by IPexpress.
10. These numbers are generated using best case PLL located in the center of the device.
11. Uses SSTL25 Class II Differential I/O Standard.
12. All numbers are generated with ispLEVER 8.1 software.
13. For details on -9 speed grade devices, please contact your Lattice Sales Representative.

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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Figure 3-11. Write Through (SP Read/Write on Port A, Input Registers Only)

Note: Input data and address are registered at the positive edge of the clock and output data appears after the positive edge of the clock.

A0 A1 A0

D0 D1

D4

tSU

tACCESS tACCESS tACCESS

tH

D2 D3 D4

D0 D1 D2Data from Prev Read
or Write

Three consecutive writes to A0

D3DOA

DIA

ADA

WEA

CSA

CLKA

tACCESS
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Figure 3-14. Jitter Transfer – 3.125 Gbps

Figure 3-15. Jitter Transfer – 2.5 Gbps
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Serial Rapid I/O Type 2/CPRI LV E.24 Electrical and Timing Characteristics
AC and DC Characteristics
Table 3-15. Transmit

Table 3-16. Receive and Jitter Tolerance

Symbol Description Test Conditions Min. Typ. Max. Units

TRF
1 Differential rise/fall time 20%-80% — 80 — ps

ZTX_DIFF_DC Differential impedance 80 100 120 Ohms

JTX_DDJ
3, 4, 5 Output data deterministic jitter — — 0.17 UI

JTX_TJ
2, 3, 4, 5 Total output data jitter — — 0.35 UI

1. Rise and Fall times measured with board trace, connector and approximately 2.5pf load.
2. Total jitter includes both deterministic jitter and random jitter. The random jitter is the total jitter minus the actual deterministic jitter.
3. Jitter values are measured with each CML output AC coupled into a 50-Ohm impedance (100-Ohm differential impedance).
4. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
5. Values are measured at 2.5 Gbps.

Symbol Description Test Conditions Min. Typ. Max. Units

RLRX_DIFF Differential return loss From 100 MHz to 2.5 GHz 10 — — dB

RLRX_CM Common mode return loss From 100 MHz to 2.5 GHz 6 — — dB

ZRX_DIFF Differential termination resistance 80 100 120 Ohms

JRX_DJ
2, 3, 4, 5 Deterministic jitter tolerance (peak-to-peak) — — 0.37 UI

JRX_RJ
2, 3, 4, 5 Random jitter tolerance (peak-to-peak) — — 0.18 UI

JRX_SJ
2, 3, 4, 5 Sinusoidal jitter tolerance (peak-to-peak) — — 0.10 UI

JRX_TJ
1, 2, 3, 4, 5 Total jitter tolerance (peak-to-peak) — — 0.65 UI

TRX_EYE Receiver eye opening 0.35 — — UI

1. Total jitter includes deterministic jitter, random jitter and sinusoidal jitter. The sinusoidal jitter tolerance mask is shown in Figure 3-18.
2. Jitter values are measured with each high-speed input AC coupled into a 50-Ohm impedance.
3. Jitter and skew are specified between differential crossings of the 50% threshold of the reference signal.
4. Jitter tolerance, Differential Input Sensitivity and Receiver Eye Opening parameters are characterized when Full Rx Equalization is enabled.
5. Values are measured at 2.5 Gbps.
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Figure 3-20. sysCONFIG Parallel Port Read Cycle

tSSCL CCLK Minimum Low Pulse 5 — ns

tHLCH HOLDN Low Setup Time (Relative to CCLK) 5 — ns

tCHHH HOLDN Low Hold Time (Relative to CCLK) 5 — ns

Master and Slave SPI (Continued)

tCHHL HOLDN High Hold Time (Relative to CCLK) 5 — ns

tHHCH HOLDN High Setup Time (Relative to CCLK) 5 — ns

tHLQZ HOLDN to Output High-Z — 9 ns

tHHQX HOLDN to Output Low-Z — 9 ns

1. Re-toggling the PROGRAMN pin is not permitted until the INITN pin is high. Avoid consecutive toggling of the PROGRAMN.

Parameter Min. Max. Units

Master Clock Frequency Selected value - 15% Selected value + 15% MHz

Duty Cycle 40 60 %

LatticeECP3 sysCONFIG Port Timing Specifications (Continued)
Over Recommended Operating Conditions

Parameter Description Min. Max. Units

CCLK

CS1N

CSN

WRITEN

BUSY

D[0:7]

tSUCS tHCS

tSUWD

tCORD

tDCB

tHWD

tBSCYC

tBSCH

tBSCL

Byte 0 Byte 1 Byte 2 Byte n*

*n = last byte of read cycle.
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Figure 3-26. Configuration from PROGRAMN Timing

Figure 3-27. Wake-Up Timing

DONE

CCLK

CFG[2:0] 1

USER I/O

INITN

PROGRAMN

tPRGMRJ

t DINIT

t
DPPINIT

t DINITD

t
IODISS

Valid

1. The CFG pins are normally static (hard wired)

Master CCLK Output

DONE

VCC

INITN

tMWC tCZ

Bitstream Start

Bitstream End
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Point-to-Point LVDS (PPLVDS)
Over Recommended Operating Conditions

RSDS
Over Recommended Operating Conditions

 Description Min. Typ. Max. Units

Output driver supply (+/– 5%)
3.14 3.3 3.47 V

2.25 2.5 2.75 V

Input differential voltage 100 — 400 mV

Input common mode voltage 0.2 — 2.3 V

Output differential voltage 130 — 400 mV

Output common mode voltage 0.5 0.8 1.4 V

Parameter Symbol Description Min. Typ. Max. Units

VOD Output voltage, differential, RT = 100 Ohms 100 200 600 mV

VOS Output voltage, common mode 0.5 1.2 1.5 V

IRSDS Differential driver output current 1 2 6 mA

VTHD Input voltage differential 100 — — mV

VCM Input common mode voltage 0.3 — 1.5 V

TR, TF Output rise and fall times, 20% to 80% — 500 — ps

TODUTY Output clock duty cycle 35 50 65 %

Note: Data is for 2 mA drive. Other differential driver current options are available.
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PICs and DDR Data (DQ) Pins Associated with the DDR Strobe (DQS) Pin
PICs Associated with 

DQS Strobe PIO Within PIC
DDR Strobe (DQS) and 

Data (DQ) Pins

For Left and Right Edges of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ

B DQ 

P[Edge] [n] 
A [Edge]DQSn

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

For Top Edge of the Device

P[Edge] [n-3] 
A DQ 

B DQ 

P[Edge] [n-2] 
A DQ 

B DQ 

P[Edge] [n-1] 
A DQ 

B DQ 

P[Edge] [n] 
A [Edge]DQSn 

B DQ 

P[Edge] [n+1] 
A DQ 

B DQ 

P[Edge] [n+2] 
A DQ 

B DQ 

Note: “n” is a row PIC number. 
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm
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LatticeECP3 Devices, Green and Lead-Free Packaging
The following devices may have associated errata. Specific devices with associated errata will be notated with a 
footnote.

Commercial

Part Number Voltage Grade Power Package1 Pins Temp. LUTs (K) 

LFE3-17EA-6FTN256C 1.2 V –6 STD Lead-Free ftBGA 256 COM 17

LFE3-17EA-7FTN256C 1.2 V –7 STD Lead-Free ftBGA 256 COM 17

LFE3-17EA-8FTN256C 1.2 V –8 STD Lead-Free ftBGA 256 COM 17

LFE3-17EA-6LFTN256C 1.2 V –6 LOW Lead-Free ftBGA 256 COM 17

LFE3-17EA-7LFTN256C 1.2 V –7 LOW Lead-Free ftBGA 256 COM 17

LFE3-17EA-8LFTN256C 1.2 V –8 LOW Lead-Free ftBGA 256 COM 17

LFE3-17EA-6MG328C 1.2 V –6 STD Green csBGA 328 COM 17

LFE3-17EA-7MG328C 1.2 V –7 STD Green csBGA 328 COM 17

LFE3-17EA-8MG328C 1.2 V –8 STD Green csBGA 328 COM 17

LFE3-17EA-6LMG328C 1.2 V –6 LOW Green csBGA 328 COM 17

LFE3-17EA-7LMG328C 1.2 V –7 LOW Green csBGA 328 COM 17

LFE3-17EA-8LMG328C 1.2 V –8 LOW Green csBGA 328 COM 17

LFE3-17EA-6FN484C 1.2 V –6 STD Lead-Free fpBGA 484 COM 17

LFE3-17EA-7FN484C 1.2 V –7 STD Lead-Free fpBGA 484 COM 17

LFE3-17EA-8FN484C 1.2 V –8 STD Lead-Free fpBGA 484 COM 17

LFE3-17EA-6LFN484C 1.2 V –6 LOW Lead-Free fpBGA 484 COM 17

LFE3-17EA-7LFN484C 1.2 V –7 LOW Lead-Free fpBGA 484 COM 17

LFE3-17EA-8LFN484C 1.2 V –8 LOW Lead-Free fpBGA 484 COM 17

1. Green = Halogen free and lead free.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-35EA-6FTN256C 1.2 V –6 STD Lead-Free ftBGA 256 COM 33

LFE3-35EA-7FTN256C 1.2 V –7 STD Lead-Free ftBGA 256 COM 33

LFE3-35EA-8FTN256C 1.2 V –8 STD Lead-Free ftBGA 256 COM 33

LFE3-35EA-6LFTN256C 1.2 V –6 LOW Lead-Free ftBGA 256 COM 33

LFE3-35EA-7LFTN256C 1.2 V –7 LOW Lead-Free ftBGA 256 COM 33

LFE3-35EA-8LFTN256C 1.2 V –8 LOW Lead-Free ftBGA 256 COM 33

LFE3-35EA-6FN484C 1.2 V –6 STD Lead-Free fpBGA 484 COM 33

LFE3-35EA-7FN484C 1.2 V –7 STD Lead-Free fpBGA 484 COM 33

LFE3-35EA-8FN484C 1.2 V –8 STD Lead-Free fpBGA 484 COM 33

LFE3-35EA-6LFN484C 1.2 V –6 LOW Lead-Free fpBGA 484 COM 33

LFE3-35EA-7LFN484C 1.2 V –7 LOW Lead-Free fpBGA 484 COM 33

LFE3-35EA-8LFN484C 1.2 V –8 LOW Lead-Free fpBGA 484 COM 33

LFE3-35EA-6FN672C 1.2 V –6 STD Lead-Free fpBGA 672 COM 33

LFE3-35EA-7FN672C 1.2 V –7 STD Lead-Free fpBGA 672 COM 33

LFE3-35EA-8FN672C 1.2 V –8 STD Lead-Free fpBGA 672 COM 33

LFE3-35EA-6LFN672C 1.2 V –6 LOW Lead-Free fpBGA 672 COM 33

LFE3-35EA-7LFN672C 1.2 V –7 LOW Lead-Free fpBGA 672 COM 33

LFE3-35EA-8LFN672C 1.2 V –8 LOW Lead-Free fpBGA 672 COM 33

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.


